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About This Guide

About This Guide

This guide has been written to assist you when using web services from the Spatial NI
ArcGIS Online (AGOL) in ArcGIS Pro.

Text highlighted in bold are actions that you will need to complete.

When you see this box...

Discover more amazing ways you can use the Spatial NI services,
OR Top tips for using ArcGIS Pro.

What is Spatial NI?

Spatial NI is Ordnance Survey of Northern Ireland’s web mapping platform. It provides
you with access to not only Ordnance Survey’s authoritative mapping data, but other
geospatial information from multiple providers across the public and private sectors.

Components of Spatial NI:

Spatial NI Website Spatial NI NIMA Portal Spatial NI for INSPIRE
The Spatial NI website enables | Access the Spatial Data Infrastructure | Spatial NI for INSPIRE provides a
the public citizen to view and | (SDI) available to all recipients of the | network of spatial data, accessible
interrogate OSNI maps with other | Northern Ireland Mapping Agreement | under the INSPIRE Directive, that

spatial data. It also contains a | (NIMA) - (Login is required). can be used to promote and support
handy gallery of other mapping environmental protection
applications.

What is ArcGIS Online?

ArcGIS Online is a component of the Esri platform and is part of their geospatial
cloud. It enables you to connect people, locations and data using interactive
maps. You can work with smart, data driven styles, intuitive analysis tools that deliver
location based intelligence and share your insights with the world or specific groups.

Who can gain Access to Spatial NI Content via AGOL?
Access to the Spatial NI content via AGOL is available to all NIMA participants who
are unable to connect to the Spatial NI NIMA Portal.

Spatial NI: ArcGIS Online Services - ArcMap Page | 5



About This Guide

How to gain Access to the Spatial NI AGOL?

You will need to have an AGOL account for your organisation and have access to
administrative privileges. The data is exchanged via a group established on the Spatial
NI AGOL, which is then shared with specific members of your organisation.

If after reading this document you would like to know more on how to configure this
access, email us for advice.

What is ArcMap?

Arcmap was Esri's desktop GIS product that provided the ability to complete
professional 2D and 3D mapping and analysis. It was initially released in 1999 with
the current version (10.6.1) being made available in July 2018. ArcMap has been
replaced by ArcGIS Pro (released in 2015) as Esri’'s main desktop GIS product.

New to using ArcMap?
Complete Esri's online training to find out how you can make the most of ArcMap.

Page | 6 Spatial NI: ArcGIS Online Services - ArcMap
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Accessing Spatial NI Services
Accessing Spatial NI Services

Spatial NI contains a wealth of geospatial data from a diverse range of organisations.
This information can be easily leveraged within ArcMap to help you complete analysis,
identify trends and make informed decisions.

Spatial NI has facilitated two methods by which you can easily leverage content into
ArcGIS Pro.

These are:

e Spatial NI NIMA Portal — A high availability instance of ArcGIS Enterprise which
offers you a single sign-on experience. This is facilitated by using Active
Directory Federated Service (ADFS).

e ArcGIS Online (AGOL) — Easily access content via your own organisations
AGOL account. You will need to have a level 2 named user within your
organisation to connect via this method.

Connecting to Spatial NI via ArcGIS Online (AGOL)

To connect to and leverage content from Spatial NI via ArcGIS Online, you will need
to have a configured level 1 or a level 2 named user account within your organisations
AGOL.

Your AGOL credentials
Your AGOL named user account will need to have certain privileges configured. To
check this you may need to consult with your organisations AGOL administrator.

A user for connection to Spatial NI must have the following configuration:

Role: User (default)

New member

First name Last name

| Test |

Email address Username

tech.spatialni@finance-ni.gov.uk | |Tes‘tUBer1230 |

User type

Creator (formerl ly Level 2)

. Compatible with all roles and licenses
114 available

Role Temporary password

[oer -] | ......... |
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Role privileges: Join external groups

Accessing Spatial NI Services

Role privileges

General Privileges

[[] Members

[0 view

[[] Sharing

[T Share with groups

[ Share with organization

[[J Share with public

[J Make groups visible to organization
[[J Make groups visible to public

[ Make groups available to Open Data

[[] Open Data

O Manage Open Data site(s)

Import settings from an existing role or template

[l

Toggle all on Collapse all

[=] Groups [-1

OJ Create, update, and delete
Join organizational groups

[¢] Join external groups

[[J View groups shared with organization

[[] Premium Content [

O Geocoding

O Network Analysis
O Spatial Analysis
[J GeoEnrichment
[[J Demographics
[ Elevation Analysis

[[] Content [

O Create, update, and delete
] Publish hosted feature layers
] Publish hosted tile layers

[] Publish hosted scene layers

[0 View content shared with organization
[] Features [-]

[ Edit
[C] Edit with full control

Who can see your profile?: Everyone

Test 's Profile

First Name Who can see your profil
Test ‘
Pr ite
Last Name O privete
User ‘ Language
Click thumbbnail to change image. ‘ English - English v
New Email
tech.spatialni@finance-ni.gov.uk ‘ Number and date format (D
‘ Us-Us v
Confirm Email
‘ ‘ Region
United Kingdom
Username Units
TestUser1230 ‘ Motric v

Page | 8
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Accessing Spatial NI Services

Getting access to Spatial NI
Once you have checked that your AGOL account has the correct permissions, you
will need to select which Spatial NI groups you would like to access from the list

below:

Group Name

Description

Contains current and historical environment feature

Want to Join?

deprivation maps.

i v x

Environment layers, incl. NI designated sites.

Geology Contains map image layers showing features of NI ‘/ X
Geology.
Contains map image layers showing water \/ X

Hydrology distribution and flooding data.

OSNI- Elevation Contains OSNI Terrain data. \/ X

S Contains historical line drawn and early digital maps ‘/
OSNI: Historical X
Istorica of NI throughout the 20" century.

OSNI- Fusion Contains Qynamlc feature layers derived from the ‘/ X
OSNI Fusion basemap.

OSNI: Imagery Con'talr.15f the gurrent orthophotography mosaic and \/ X
the individual imagery captured by year.

OSNI: Location Contalns_, pointer services, address information and ‘/ X
boundaries for NI.

OSNI: Opendata Contams' the opendata offered by OSNI, including: \/ X
boundaries, raster basemaps and transport network.

People and Place Contains data.for soc.|al interest mgludlng: schools ‘/ X
playparks, police stations and public areas.

Statistics Contains statistical data from the NI 2011 census and \/ X

Then contact the Spatial NI Support Team by email, providing the following details to
be granted access to the correct groups.

e Your AGOL username
e The list of groups which you would like to access

Spatial NI: ArcGIS Online Services - ArcMap
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Accessing Spatial NI Services

Accepting a request notification
Once, the Spatial NI support team have confirmed your access permissions, you will
need to accept the group invitation to join the group.

1. Login to your organisations AGOL.
2. Click the notifications icon on the top menu bar - View your invitations

O\ .ﬁ' - Test User
= e TestUser1230

You have been invited to join AGOL Sharing Test.
| View your invitations | X

a minute age

Dismiss all

3. From the list of invitations, select the AGOL group you wish to join = Click Join
this group

Invitations X

You have been invited to join the following groups:

/&\ AGOL Sharing Test
S Invited by SpatialNl Admin on February 4, 2019

+ Join this group | @ Decline

1-10f1 results

Page | 10 Spatial NI: ArcGIS Online Services - ArcMap



Accessing a group

Accessing Spatial NI Services

The group will now appear in your My Groups tab, within Groups.

1. Click the group name link to enter the group page, and view content.

Home Gallery Msp Scene Groups

Content Organization

My Groups

O\ ﬂ' HH Test User

TestUser1230

Featured Groups My Organization's Groups

Create group

Filters

Q. Search My Groups

1| AGOL Sharing Test |

Cnly show groups with new

membership requests

~ Owner

Owned by Me
Owned by Others

<

Date Created

Today
Yesterday
Last 7 Days
Last 30 Days

Custom Range...

Owner: SpatialNIAdmin
| Crested: Jan 26,2019 Last Updated: Feb 4,2019  Viewabls by: (& Everyons (public)

= Title  {}] Filter

<] Leave Group

7/

*NOTE: Click Leave Group at any time you wish to remove yourself from the group.
This will have no effect on the group or content within.

Home Gallery Map Scene Groups

AGOL Sharing Test

Content Organization

O\ Q HH Test User

= = TestUser1230

Overview Content Members

owned by SpatialNIAdmin

Description

An in-depth description of the group iz not available.

Latest Content

Coverage Grid - 50K
9 by SpetielNIAdmin

Coverage Grid - 10K
9 by SpetizINIAdmin

Crested: Nov 20, 2018
Updeted: Jan 23, 2019
View Count: 3

Created: Nov 20, 2018
Updeted: Jan 25,2019
View Count: 4

A brief summary of the group is not available.

& - & -

#

Tranzport 50K - Metwork lines
9) by SpatielNIAdmin

Crested: Nov 21,2018
Updeted: Jen 24, 2019

View Count: 6

G e

View All Group Content

Shars

Details

Crested: January 26, 2019
Viewable by: Everyone (public)
Contributors: Only group owner and managers

&2 @3

Owner

SpatialNIAdmin

g Leeve Group

Membership

+ You ars a member

Tags

TEST

Spatial NI: ArcGIS Online Services - ArcMap
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Finding and Viewing Content
Finding and Viewing Content

Spatial NI provides OSNI and third party organisations data via AGOL shared groups.
It is also possible to gain access to Spatial NI basemaps upon request.

Adding data from the Spatial NI NIMA Portal to your Map
Confirm ArcMap is connected to the Spatial NI NIMA Portal, as by default ArcMap will
connect to ArcGIS Online.

You can add web maps or feature layers from the Spatial NI NIMA Portal to your
ArcMap document.

1. Click File > Add data - Add data from ArcGIS portal

File i Edit View Bookmarks Insert Selection Geoprocessing Customize Wind
0 New. Ctrl+N 1 v |j
ES Open- GO N @M RIT)

Save Ctrl+S [ =
a ElETy ¢

Save As.., I

2 x

Save A Copy...

Share As 4 |

Add Data v nddData..
HR sign Out - dof whetstonet@nigov.net 22 Add Basemap...
BE  ArcGIS Portal... BE  Add Data From ArcGIS Portal...
Page and Print Setup... £+ Add XY Data...
BB Print Preview... Geacoding v
& Print... +# Add Route Events...

Export Map... & Add Query Layer...

2. A dialogue box will open which allows you to search for content in the Spatial
NI NIMA Portal to add to ArcMap.

@ ArcGls

<7 [ Featured MyMapsand Data My Groups »

I. Featured

Page | 12 Spatial NI: ArcGIS Online Services - ArcMap



Finding and Viewing Content

Spatial NI Basemaps
ArcMap will automatically connect to the basemap gallery from your active
portal/AGOL account. In most cases this will be the default Esri basemaps. Your
AGOL administrator can check your basemap settings through the Organisation tab
- Settings = Map. It is possible to request the gallery of Spatial NI basemaps to be
configured for use in your own AGOL. Ask your AGOL Administrator to contact Spatial

NI via email.

Spatial NI basemaps are a collection of non-editable cached maps, which display
OSNI data in a variety of styles and scales. The basemap is the lowest layer of the

map and is used to give spatial context to the feature layers above.

A selection of Spatial NI basemaps are available which are summarised below:

Basemap Name

Description

Cache Scales

_ A coloured raster map of NI highlighting features such as: 1:550,000 -
(1:250,000) Colour a4 golf courses, settlements, and sites of interest. 1:120 000
A black and white outline raster map of NI highlighting 1:550,000 -
(1:250,000) Outline  features such as: roads golf courses, settlements, and 1:120.000
sites of interest.
A largescale derived raster map showing detailed 1:20,000 -
1:10,000 information on features such as roads, fields, water and 1:5,000
settlements.

. _ A series of raster maps tailored to outdoor leisure 1:30,000 -
Activity (1:25,000)  ,ivities centred on six regions of NI (e.g. The Mournes). 1:10.000
Discoverer A mid-scale raster map giving full coverage of NI showing 1:60,000 -
(1:50,000) all roads, tourist information and relief. 1:20.000

. A mid-scale raster map giving full coverage of NI showing 1:60.000 -
Discoverer all roads, tourist information and relief. This includes the '
(1:50,000)(Grid) Lo : ' 1:20,000

Irish grid reference lines.

A scalable basemap depicting detail from a NI scale to 1: 2,000,000 -
Fusion the most detailed (derived from OSNI Fusion). This 1:500

includes data from Ordnance Survey Ireland.
Fusion Light A grayscale styling of the Fusion basemap. 1 2,000,000 -

1:500

High quality 3-band Ariel photography offering a detailed 1: 2,000,000 -
Orthophotography birds-eye view of the landscape. 1:500

A detailed raster map showing clear street level 1:20,000 -
Streetmap information for towns and cities in NI. 1:5,000

*This list is continually being updated as and when new data becomes available.

Spatial NI: ArcGIS Online Services - ArcMap
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Finding and Viewing Content

Add basemap to ArcMap

A basemap provides a background or geographical context for the content you want
to display in a map. When you create a new map, you can choose which basemap
you want to use from the Spatial NI basemap gallery.

The Spatial NI basemap gallery includes a variety of choices, including topography,
imagery, and streets.

1. Verify that you are signed in to a Spatial NI NIMA Portal.
2. Select Add Data, then Add Basemap.

okmarks Insert Selection Geoprocessing Customize |
TR %9 ob-| il
fad + [ & Add Data...

R ED B9 Add Basemap...
HE  Add Data From ArcGIS Portal...

2| 4= =

3. Click the thumbnail of the basemap you want to use in your map.

i Add Basemap X

1:250,000 (Colour) 1:250,000 (Outline)

Activity (1:25,000) Discoverer (1:50,000) Discoverer (1:50,000)
(Grid)

Fusion Fusion: Light StreetMaps

4. View information about a basemap by right clicking on the basemap in the
table of contents and selecting Properties.

Page | 14 Spatial NI: ArcGIS Online Services - ArcMap



Finding and Viewing Content

Spatial NI Metadata
Metadata provides information about mapping layers, including: owner, contact
details, creation date, data origins, and legal restrictions of use.

Spatial NI uses the INSPIRE metadata standard for all hosted content. To view
metadata for Spatial NI Content; access via your AGOL web interface, within the
AGOL shared group. The content item page will contain the metadata from Spatial NI.

Orthophotography » ex

# EditThumbnail Open in Map Viewer hd

Most recently availalble orthophotegraphy. # Edit

ins Viewer
# Tile Layer by spatialniportaladmin Open in Scene Viewe:

Creeted: 8 Feb 2019 Updeted: 21 Feb 2019 View Count: 1 | Open in ArcGIS Deskiop |
*  Add to Fauories | Share |
P Metadsta |
Description # Edit |
Orthophotography is photographs of the earth’s surface from which accurate measurements can be taken. OSNI
orthophotographs are created from high quality asrial images with distortions removed resulting in a scale-accurate bird's eye ltem Information @ Learnmore
view of the landscape. This secured orthophotography servics is updated on a quarterly basis using the latest ortho-rectified . |
imagery. The flown_date indicates the date the imagery was collected. Some tiles may have instances of anaomalies e.q. cloud Low High
cover, hence when this occurs a previous ortho image may be stitched to the most recent. These are tracked using a seamline
1 Top Improvement: Ade a longer summary

dataset. This seamline dataset has been added as the footprint for this OSNIOrthophotograshy image service. As such, the
flown_date may differ across an individual tile, if 2 seamline is present. Data owner: Ordnance Survey of Northern Ireland Date
published - January 2019 Date updated - N/A Scale thresholds - N/A Access and use constraints Details
Source: Map Service
Size: 1 KB

Layers
Shared with: Everyane (public)

OSNIOrthophotography

Owner & Change Owner

Terms of Use # Edit 2 spstialniporsladmin

Add any special restrictions, disclaimers, terms and conditions, or limitstions on using the item's content.

Spatial NI: ArcGIS Online Services - ArcMap Page | 15



Using Spatial NI Services in ArcMap
Using Spatial NI Services in ArcMap

Spatial NI are aware that analysis is a central feature to any GIS project. For some of
our operational services, we offer you the ability to complete additional GIS functions
depending on the type of service being used. These functions are explained below:

Service Type Description Analysis
) Pre-rendered map raster tiles. You will not be able to complete an
I?:E Tile Layer P o mp y
analysis using these services.
Imagery Dynamically displayed raster You will be able to complete imagery
E Layer data. based analysis on these services.

A feature layer is a grouping of You will be able to view, edit, analyse,

Feature similar geographic features (e.qg. and execute queries against features
O buildings, land parcels or and their attributes. You will also be
Layer roads). Features can be points,  able to change the layers symbology.

lines or polygons.

A collection of map cartography You will not be able to complete any
E Map Image based on vector data. Map analysis using these services.
Layer image layers are dynamically
rendered image tiles.

Symbology
You can symbolise feature layers in different ways depending on the type of data being
presented. Symbols allow you to illustrate a unique difference between features.

Once a layer has been added to the map it will symbolise the features with default
symbols.

You can symbolise polygon, line or point features.
Customising Symbology

1. Select a feature layer by right clicking its title in the Table of Contents pane.
2. Select Properties from the drop down menu.

Page | 16 Spatial NI: ArcGIS Online Services - ArcMap



Using Spatial NI Services in ArcMap

= = Layers

=] Boundaries - Wards (2012) (Largescale)

Ll

Copy
Remove

Open Attribute Table

Joins and Relates 3

Zoom To Layer

Visible Scale Range 3
Use Symbol Levels

Selection 3
Label Features

Edit Features 3

Convert Features to Graphics...

Data »

Save As Layer File...

=g

f;) Create Layer Package...
| Properties... } A /
.

Layer Properties

Display the properties of this layer

I

L

3. A Layer Properties window will open, select the Symbology tab.

Layer Properties

Show:

Features
Categories
Quantities

Charts

Multiple Attributes

3
7]

General Source Selection Display Fields Defintion Query Labels Joins & Relates Time

|Dra1|r all features using the same symbol. Impart ...

Symbal

Advanced -

Legend

Label appearing next to the symbal in table of contents: |:|

Description...

Additional description appearing next to the symbol in your map's legend

HTML Popup

Apply

X

4. Select your preferred symbology type in the Layer Properties window.

Spatial NI: ArcGIS Online Services - ArcMap
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Using Spatial NI Services in ArcMap

Types of Symbology

For basic use the tab labelled Primary Symbology is sufficient for customising the
symbol and style. Within the Primary symbology tab you are given a drop-down
menu to select the type of symbology that will best display your data. A brief
descripting of each symbology type is outline below:

Single symbol - Single symbol symbology applies the same symbol to all
features in a layer. This symbology is used for drawing a layer with just one
category such as county boundaries.

Unique values - Unique values symbolize qualitative categories of values.
Examples include habitat types, planning zones, voting preferences, and soil
classifications.

Graduated colours - Graduated colour symbology is used to show a
guantitative difference between mapped features by varying the colour of
symbols. Data is classified into ranges that are each assigned a different colour
from a colour scheme to represent the range.

Graduated symbols - Graduated symbols are used to show a quantitative
difference between mapped features by varying the size of symbols. Data is
classified into ranges that are each then assigned a symbol size to represent
the range.

Unclassed colours - While graduated colours symbology distributes data into
discrete classes with unique symbols, unclassed colours symbology distributes
a colour scheme evenly across features.

Heat Map (point feature layers only) - Heat map symbology draws point
features as a representative surface of relative density. Use heat map
symbology when many points are close together and cannot be easily
distinguished.

Proportional symbology - Proportional symbology is used to show relative
differences in quantities among features.

Dot Density (polygon feature layers only) - Dot density symbology is one way
to represent quantities within polygons on a map. With dot density symbology,
the data you symbolize is not classified.

Dictionary renderer - Dictionary symbology is used to symbolize layers using
a dictionary of symbols configured with multiple attributes. This approach is
used when symbol specifications lead to many symbol permutations that would
be inappropriate for unique value symbology.

Page | 18 Spatial NI: ArcGIS Online Services - ArcMap



Using Spatial NI Services in ArcMap

Querying

Query expressions can be used on feature layers or on layers that contain attributes
to select a subset of features according to information contained in the attribute table
or from a spatial relationship.

Querying data can be a useful analysis tool as it can focus your target area by isolating
records.

Select by Attribute

One of the selection methods you can use to select features in a layer is to select
features using an attribute query. This is performed by using the Select By Attributes
tool.

You can provide a SQL query expression which is used to select features that match
the selection criteria.

In this example we are building a query to select all the Wards in the Belfast Local
Government District using the query selection window.

1. Click Selection at the top of the page, a drop down menu will appear. Click
Select by Attributes.

Insert | Selection | Geoprocessing  Customize Windows Help

 |E5  select By Attributes.. | FEBE %
I - BEq  Select By Location.., = _—
| Select By Attributes

Selects features by their attribute
values

undaries

Interactive Selection Method 3
2] (Larg

Selection Options...

2. Choose the layer to perform the selection against. In this example we select
Boundaries - Wards (2012) (Largescale), and define the selection method as
Create a new selection.

|°‘§é5° Boundaries - Wards (2012) (Largescale) j
[ ] Only show selectable layers in this list
Create a new selection W

= = AL
D Add to cument selection

Remowe from cument selection
g1 5elect from cument selection

Spatial NI: ArcGIS Online Services - ArcMap Page | 19



Using Spatial NI Services in ArcMap

3. Query expressions can be created using several methods:
e Using the query expression building tools.
e Type into the query selection window
e Use a query saved to disk.

4. The attribute table for the Boundaries — Wards (2012) (Largescale) feature
layer shows there are fields for WARDNAME and LGDName (Local

Government District).

OBJECTID WARDNAME WardCode LGDName
78 | THE BIRCHES MOS000235 (Armagh City, Banbridge and Craigavon
T7|THE MALL Nognoo24d  |Armagh City, Banbridge and Craigavon
78 | WARINGSTOWHN NOeoe241  |Armagh City, Banbridge and Craigavon
T9|ANDERSONSTOWM  [NOS000301 |Belfast
&l | ARDOYMNE MNOS000302 |Belfast
&1 |BALLYGOMARTIN MOB000303 |Belfast
o lpa) | YIACADRETT (Noennnand |Belfagt

5. Double click on “LGDName” to add this field to the expression query. As we
want to find all Wards that are in the Belfast LGD use the operator =. Finally,
click on Get Unique Values. A list of all LGD Name’s will appear and select

Belfast from the list.

Layer: ||°‘3"“ Boundaries - Wards (2012) (Largescale) I ﬂ

Method: Create a new selection

[]Only show selectable layers in this list

"OBJECTID"
"WARDMAME"
"WardCode"

"R REA"

> = And
4 €= QOr

_||% () Moot <

= ¢ Like "Antrim and Mewtownabbey'
"Ards and MNorth Down’

‘Amagh City, Banbridge and Craigavon’

Causzeway Coast and Glens’

>

SELECT * FROM 9 WHERE:

= Im Mull Get Unigue Values  Go To: I:I

"LGDName" = Belfast’|

Clear Verify Help Load... Save...
OK Apphy Cloge
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6. To ensure the query can be performed select Verify, and a dialogue box stating
‘the expression was successfully verified’ will appear.

7. Click OK to execute the selection expression and display the selection results.

Select by Location

This tool allows you to select features based on their location relative to features in
another layer.

In this example we will use the Select By Location tool to investigate which wards in
Northern Ireland contain a Special Area of Conservation.

1. Click Selection, then select the Select By Location option.

sert | Selection I Geoprocessing  Customize  Windows  Help
B % Select By Attributes... 4 [;] @ i ﬁm -
50 |% Select By Location... |

Editor =

Select By Location

Selects features using the location
of features in another layer.

Interactive Selection Method — »

Selection Opticns...

2. Define the selection method.

3. Choose the Target layer, this is the layer which the features will be select on.
This is Boundaries — Wards (2012) (Largescale) in this example.

Create a new selection
Create a new selection
Add to cument selection

Remowe from cumert selection
Select from cument selection

4. Choose the source layer to be used to select features from the target layer.
This is Northern Ireland Designated Sites — Special Areas of Conservation.

Select By Location .

Select features from one or more target layers based on their location in
relation to the features in the source layer.

Selection method:
select features from w

Target layer(z):

[J Maorthern Ireland Designated Sites - Spedial Areas of Conservation
Boundaries - Wards (2012) (Largescale)
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5. Define the Spatial selection method, this is how ArcMap chooses to select
features in the target layer. As we are selecting any ward containing a Special
Area of Conservation, select intersect with source layer feature. Esri
provides a document on types of supported spatial queries.

Spatial selection method for target layer feature(s):

intersect the source layer feature

intersect the source layer feature
intersect {3d) the source layer reature
are within a distance of the source layer feature

are within a distance of (3d) the source layer feature
contain the source layer feature

completely contain the source layer feature

contain {Clementini) the source layer feature

Ll are within the source layer feature

are completely within the source layer feature

are within (Clementini) the source layer feature

are identical to the source layer feature

touch the boundary of the source layer feature
share a line segment with the source layer feature
are crossed by the outline of the source layer feature

6. Click OK to execute the selection expression and display the selection results.

Select By Location pd
Select features from one or maore target layers based on their location in
relation to the features in the source layer.

Selection method:
select features from R

Target layer(s):

[ Morthern Ireland Designated Sites - Spedal Areas of Conservation
Boundaries - Wards (2012) (Largescale)

[] only show selectable layers in this list

Source layer:
|"®° Morthern Ireland Designated Sites - Special Areas of Cunsewatiunﬂ
Ise selected features (0 features selected)

Spatial selection method for target layer feature(s):

|interseu:t the source layer feature e |

[ ] apply a search distance
20000, 000000 Meters

About select by location I oK I I Apply I Close
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Using Spatial NI Services in ArcMap

Exporting Data

With ArcMap, you can export the data for a layer to another location or format or as a
subset of the features from the original data source. ArcMap can write new data to
either a shapefile or geodatabase. This data can include all the original data, a
selected set of the features, or only the features visible in the map's current extent.

1. Right-click the layer in the table of contents and click Data - Export Data.

Table Of Contents 1 x

EEELIE

= Layers

N

[ = Spatial NI Data Frame 1

SR Area:_of_Conservation)
B Copy

O

A4

X Remove
B Open Attribute Table
Joins and Relates 3

'._; » Zoom To Layer

Visible Scale Range »
Use Symbol Levels

Selection 3
Label Features

Edit Features 3

4 Convert Features to Graphics...

Convert Symbology to Representation...

| Data 3

<> Save As Layer File.. <w Export Data...
‘J-’ Create Layer Package... Export Te CAD...

[ Properties...

|§ View ltem Description...

2. Click the Export down arrow and click All features, Selected features, or All
features in View Extent.

Export Data >

() the data frame

the feature dataset you export the data into
(only applies if you export to a feature dataset in a geodatabase)

Output feature dass:

|C:'-.Llsers'-J:_'.z;fs:??::"jé“-.[lucuments"-.ExDDrt_OLrtert.shF' | E‘

Cancel
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3. Click the option for the output coordinate system you want to use.

Export Data bt
Export: | Selected features W
Use the same coordinate system as:
(@) this layer's source data
() the data frame
the feature dataset you export the data into
(only applies if you export to a feature dataset in a geodatabase)
Output feature dass:
|C:\Users\iif*jQ%\Documerﬂs\&pnﬂ_&ﬁpm.shp | B-
0K Cancel
4. Click the browse button and navigate to a location to save the exported data.
5. Type the name for the output data source.
6. Click the Save as type arrow and choose the output type.
7. Click Save.
8. Click OK.
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Using OSNI Orthophotography

What is OSNI Orthophotography?

Orthophotography is photographs of the earth’s surface from which accurate
measurements can be taken. OSNI orthophotographs are created from high quality
aerial images with distortions removed resulting in a scale-accurate bird's eye view of
the landscape. This secured orthophotography service is updated on a quarterly basis
using the latest ortho-rectified imagery. The ‘flown_date’ indicates the date the
imagery was collected. Some tiles may have instances of anaomalies e.g. cloud cover,
hence when this occurs a previous ortho image may be stitched to the most recent.
These are tracked using a seamline dataset. This seamline dataset has been added
as the footprint for this OSNIOrthophotography image service. As such, the
‘flown_date’ may differ across an individual tile, if a seamline is present.

Adding 3 Band Imagery to ArcMap
3 Band image orthophotography is available through Spatial NI and can be added to
ArcMap. 3 band imagery is displayed as red, green and blue bands.

1. Open ArcMap and sign in to the NIMA Spatial NI Portal

2. Click the Add Data icon and select Add Data from ArcGIS Portal

3. Select the My Groups tab, and then select the OSNI: Imagery tab.

4. The OSNI: Imagery group contains orthophotography from 2003 to current.
Thumbnails show the coverage extent of the year’s orthophotography. OSNI —
Orthophotography (3Band) displays the most up to date 3Band
orthophotography available.

O Altﬁls iismmm [y oo o
ontine
< Featured MyData My Groups
My Group: OSNI: Imagery
OSNI: Imagery
ropertes | Description |
Summary
Tags
Contact
[OSNI - Orthophography (38and) x| [0sNI - Orthophotography (2003) x| [0sNI - Orthophotography (2004) x| [OSNI - Orthophotography (2005) x
Dynamic Service .| Al Orthophotography flown during 2010 T All Orthophotography flown during 2010 L+~ *_ | All Orthophotography flown during 2010
flying season. Flying season. my | flying season.
>4 —y -
g = -
age Senice by spstislniportsisdmin | 24022019 Details Add | | Map Senice by spatsimportlsdmin | 25/02/2013 Details Add | | Map Senvice by spatiainiportsiadmin  25/02/2013 Details Add | | Map Service by spacisiviportsiadmin _ 25/02/2019 Details Add
[0SNI - Orthophotography (2006) x| [0SNI - Orthophotography (2007) x| [0SNI - Orthophotography (2008) x| [OSNI - Orthophotography (2009) x
~ | All Orthophotography flown during 2010 R | AllOrthophotography flown during 2010 . Al Orthophotography flown during 2010 Al Orthophotography flown during 2010
- fiying season. fying s sy | fying season g, | fing season
—y . €
- > ~
Details Add Map Service by spa portaladmin  25/02/2019 Details Add Map Service by spatiainiportaladmin  25/02/2019 Details Add Map Service by spatialniportaladmin  25/02/2019 Details Add
[ OSNI - Orthophotography (2010) x| [0SNI - Orthophotography (2011) x| [OSNI - Orthophotography (2012) x| [0sNI - Orthophotography (2013) x
k| Al Crhophotography flown during 2010 All Orthophotography flown during 2011 - All Orthophotography flown during 2012 All Orthophotography flown during 2013
flying season. . | fying season fying season. flying season
| - bying ‘\‘ln lying lying
Eoat™ ~ ot =
Details Add Map Service by spat portaladmin  25/02/2019 Details Add lap Service by spatialniportalac Details Add 3p Service by spatialniportalsdmin  25/02/2019 Details Add
[0SNI - Orthophotography (2014) x| [0SNI - Orthophotography (2015) x| [0SNI - Orthophotography (2016) x| [OSNI - Orthophotography (2017) x
’ All Orthophotography flown during 2014 All Orthophotography flown during 2015 P All Orthophotography flown during 2016 = Al Orthophotography flown during 2017
’: W, | fVing season. flying season. ’:w flying season. B | flying season.
- w ] - 2o
o Seice or s Detals Ade | | vap serve oy spsssniporatsamin 25022019 Details Add | | Map Senvie by spwsinporaaamn 2502013 Details Add | | wap Sevie by spisnporisamin 250272015 Detals Add
OSNI - Orthophotography (4Band) x| [0SNI - Orthophotography (Current) x
Dynamic Service Most recently availalble orthophotography.
nage Service by spatizinportaladmin 24022010 Details Add | | Map Service by spatsimiportslasmin  25/02/2018 Details Add
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5. To add orthophotography to your ArcMap document select Add on the OSNI —
Orthophotography (3Band) layer. This will add to the table of contents and be
visible in ArcMap.

6. The OSNI — Orthophotography (3Band) has been configured so it is only
visible at a scale of below 1:20,000. To change the scale select the scale bar,
and either type in a figure lower than 20,000 or select a pre-defined scale which
is lower than 20,000.

t Selection Gecprocessing Customize  Windows  Help

&+ - ||1:15.260 v EEE B
-EIN @ peal WS _ | Edit
01 2B

How to query flight dates using a definition query
It is possible to query the 3 band orthophotography to return the date the imagery was
captured for a specified area. The date the imagery was captured is known as the
‘flightdate’, in the imagery’s attribute table in ArcMap.

Definition queries can be used when you only want to work with and draw a subset of
the features. For example, you may only want to display imagery from certain years
within ArcMap. Definition queries are written in SQL syntax, constructed using the
guery builder. Similar to the syntax in the Select by Attribute instructions.

1. Add the 3Band Imagery to ArcMap, it should appear in the Table of Contents.
2. Right-click on the Imagery layer and select Properties.

Table Of Contents B x

BEEEIE
5 < Layers
a
RGE
I Fed: Band_1
I Green: Band_2
I Elue: Band_3

Copy
Remowve

X [

Zoom To Layer

e

Zoom To Source Resolution

Visible 5cale Range »
Refresh

EE Open Attribute Table
Selection »

Data 3

%2 Save As Layer File..,
i’ Create Layer Package...

b‘ Properties... I
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3. In the Layer Properties dialogue box select Definition Query.

Layer Properties >

General Source Key Metadata Extent Displ Symbaology Processing Templates Mosaic
Selection Fields I Definition Cuery I Status Time

Definition Query:

Query Builder...

4. Select Query Builder, this will allow you to create the SQL syntax.

Adding 4 Band Imagery to ArcMap

4 band orthophotography imagery is available through the Spatial NI NIMA Portal. 4
band imagery, typically contains red, green, blue, and near infrared bands. You can
choose to display the imagery in ArcMap as either natural colour (red, green, and blue
bands) or colour infrared (infrared, red, and green bands).

The method for adding 4 band imagery follows the same instructions as adding 3 band
imagery.

3D Analysis

OSNI have developed a digital terrain model (DTM) for Northern Ireland. This shows
the elevation of the bare Earth without structures, such as buildings. The ‘OSNI
Terrain’ layer is a 1m resolution DTM derived from the 60m DTM.

The terrain layer only contains elevation data, to add context an imagery layer will
need to be draped over the terrain layer.

The OSNI Terrain layer is not configured for use in ArcMap or ArcScene. Spatial
NI Support recommends using terrain layers in ArcPro.
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OSNI Fusion Services

The dynamic OSNI Fusion services are individual feature classes derived from OSNI
Fusion. These individual feature classes can be added to ArcMap, queried and used
for editing purposes. The services are available within the OSNI:Fusion group.

*NOTE: The dynamic Fusion services are only viewable at 1:5,000 scale or below.

You can choose to add an individual layer that you wish to query. However, this may
appear out of context and it may be more beneficial to add all the individual layers
before editing. For viewing purposes it is important that these layers are listed in the
correct order in the Contents pane. List as follows (uppermost — lowest):

OSNI - Fusion:
OSNI - Fusion:
OSNI - Fusion:
OSNI - Fusion:

Feature Perimeter
Buildings
Structures Line
Structures Polygon

e OSNI - Fusion: Transport Casing
e OSNI - Fusion: Transport Non-Vehicular
e OSNI - Fusion: Water Tidal Measure

OSNI - Fusion:
OSNI - Fusion:

Water Course Line
Water Course Polygon

e OSNI - Fusion: Standing Water Line
e OSNI - Fusion: Standing Water Polygon
e OSNI - Fusion: Ground Cover (Vegetation)

e OSNI - Fusion: Ground Cover (Man-made)
e OSNI - Fusion: Ground Cover (Bare Soil)
e OSNI - Fusion: Land Parcel
e OSNI - Fusion: Geographic Extent
e OSNI - Fusion: Ireland Sea

Querying

All the dynamic Fusion services can be queried according to a field within the attribute
table. Select the desired layer in the Contents pane and right-click to open the Attribute
table. Change to the field view to see the data available to query.

Either add a definition query to the feature layer or select by attributes to isolate a
select set of records. See ‘Querying — 3 Band Image Analysis’ for a step by step guide.
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Snapping

Snapping is a tool used to assist drawing features on a map, in relation to existing
points, lines or polygons. To create new features you first need to create a new file
geodatabase and feature class. The new feature can be set to snap to a features:
point, end, vertex, edge, mid-point, intersection or tangent.

Creating a file geodatabase
A file geodatabase is stored within your current project in ArcMap. It is a type of folder
that allows you to create your own feature classes and content within.

1. Right-click in the Catalog pane and select New > File Geodatabase.

B Copy

w Refresh
| [New] » |

[

Folder
File Gecdatabase

|Ej ltem Description...

[~ Properties...

—

(L™

Personal Geodatabase

~

Database Connection...

il

ArcGIS Server Connection...

> & |

&

Layer...
Group Layer

e
s

Python Toolbox
Shapefile...

Toolbox

dBASE Table

LAS Dataset
Address Locator..,

Composite Address Locator..,

AML Document

HeSEI® N 0D

2. A new file geodatabase called New File Geodatabase.gdb will appear in the
Catalog pane.

3. To change the name, right click on the new file geodatabase and select
Properties.
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|3 Default.gdb &
Lj Mew File Geodatabase.gdb
& Toolbox.thx B Copy
X Delete
Rename
o Refresh

L& Make Default Geodatabase

Administration *
| 3 Folder Connections Distributed Geodatabase 3
i [ Toolboxes
| @ Database Servers e d
| @ Database Connections Import »
Export »
g Share as Geodata Service...
=] Itern Description...
[ Properties...

4. Type your chosen name in the Database Properties window.

Database Properties x

General  Domains

Mame: | C:\Users'dof \DocumEntsarcGISew File Geodat

Type: File Geodatabase

Distributed Geodatabase Status

This is not a replica geodatabase.

Configuration Keywords

Click the button for a list of all keywaords defined far this database.

Configuration Keywords...

Upgrade Status

This 10 Geodatabase matches the ArcGIS release you are currently
using.

Upagrade Geodatabase

I OK I | Cancel Apply

Page | 30 Spatial NI: ArcGIS Online Services - ArcMap



Sharing Maps
Sharing Maps

Page Layout

A page layout is a collection of map elements organised on a virtual page designed
for map printing. Common map elements include one or more data frames (each
containing an ordered set of map layers), a scale bar, north arrow, map title,
descriptive text, and a legend.

Though page layouts can be exported and used electronically, they are primarily
designed for printing. Page layouts can have either a landscape (wide) or portrait (tall)
orientation. Page size varies depending on the specifications for the output. What you
see on the layout is what you get if you print or export the map to the same page size.

". NEWTOWNABBEY
/ Cultra

=

N 7 T 0y T
Burcide s oo ﬂ N \(\\ N o y \ P
A Teuad 2N/ WHIT
- 4 A \
” (
~ (3 =
M CARRICKFERGUS
|| 4 S e ¢ 4
]2 L RO = L .
SR N MorkonJ GREENISLAND
o Sty ARMAG 3
. , @,é;%?wnﬁo_m‘r}ghl 8 S5 4
o § .| 4-Database Right 2018, G/ \ hestibey HELEN'S BaY
| \ = \JOrdnance Survey Ireland - \ A Ballrobert
g W\ e 2 S'pan%\Nl"\ga"?@N‘ice provided [* o 1 —
RO 57, Ordnance‘Sury.ey.of N
{ ]
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<

Flatfiedd]
Boardmils

TN SANTFELD N\
BaleysglCrown Cppyright & Database/Right2018, © Ordnance Survey Ireland -

S e SLHusBorouGH
¢ > Spétlaljtljuxrs 3 sevice prcvlded’by Ordnance S{urveygnfnmoﬁn\e»rn Ireland®

Belfast, Co. Antrim

N 0 125 25 5 5 10
A Miles
Wé‘;}i
I
S ORDNANCE SURVEY

OF NORTHERN IRELAND ”

Map displayed in layout view, produced using Spatial NI services
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Creating a new page layout

1. Select Layout View from the View menu or by clicking the Layout View button
on the lower left of the map display.

File Edit | View | Bookmarks Insert Seleq
DE, Data View

&l a@ L Layout View

Graphs »

Reports 3
Table Of Con

Scroll Bars

=] Laye

[<]<]

Status Bar

[~ Data Frame Properties...
o Refresh F5
Pause Drawing F9

-
N

Pause Labeling

E

Adding a data frame to the page layout
The data frame displays a collection of layers drawn in a particular order for a given

map extent and map projection. You can insert additional data frames. These
additional data frames may be for overview or detail maps.

1. Select the Insert menu and select Data Frame

File Edit Wiew Bookmarks Ilnsertl Selection  Geopr
D E‘E‘ % % |§ Data Frar‘nel
® S [OQ@ 352

A Ted

Dynamic Text 3

Table Of Contents

2. To make a data frame active, right-click on its name in the table of contents
and select Activate or single-click the data frame on the page layout.
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File Edit View Bookmarks Insert Selection Geoprocessing Cush

ODegEs Bx|9 b

R x] @ A
( Tl 1007 =

Table Of Contents 8

EEELE

=4 Layers

=1 Spatial NI Data Frame 1

< AddData...
&2 New Group Layer
@ Mew Basemap Layer

[ Copy

X Remove

Reference Scale 3

Labeling 3

' Properties...

Adding other map elements to the page layout

Sharing Maps

1. Use the Insert menu to select other map elements to add to your layout

(Legend, North Arrow, Scale Bar, and Scale Text).

File Edit View Bookmarks | Insert | Selection Geoprod
D & B x = Data Frame 51|
® R8Ok el Title

r Text
& e | R E

Dynarnic Text 3
Table Of Contents

_.
=
=

g

B

) - = Meatline...
B L
7 Layers i= Legend..
w Morth &irrow...
= Eé Spatial Ml Data Frame 1 E Scale Bar...
= Areas_of_Conservation | # Scale Text..
- .
= Picture...
lm| Object..
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2. You can use this menu to add a Title to the map.

File Edit View Bookmarks
O da

® OOkl
D | R
Table Of Contents

Insert | Selection Geoprog

= Layers

F = Spatial Ml Data Frame 1
= Areas_of_Conservation

% = DataFrame 51 |
Tile  Title
A Tedt o

Dynamic Text » .

[] Meatline...
i=  Legend.. |
& Morth Arrow...
== Scale Bar...
10 Scale Text..
El Picture...
@ Object..

3. The Draw toolbar can be used to add graphic shapes such as rectangles,
lines, and points.

K [0 b

x| @

Insert  Selection  Geoprocessing CustomizeIWindows Help

Toolbars 2 3D Analyst
Extensions... Advanced Editing
Add-In Manager... Animation
Customize Mode... ArcScan

Style Manager... CoGO

ArcMap Options...

Data Driven Pages

120 |21 |22 |23 |24 |25 |26 |27

Data Frame Tools

Distributed Geodatabase
I Draw

Edit Vertices

Editor

Effects

Feature Cache

Feature Construction
Geocoding

Geodatabase History
Geometric Network Editing
Georeferencing

Geostatistical Analyst
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Sharing Maps

After creating your map, there are several methods of sharing it. A popular method of
sharing is exporting the map to a chosen a file format. You can then decide what to do

with the file.

1. To export a map, select File and then Export Map.

Q Untitled - ArcMap

HH  ArcGIS Portal...

3 Page and Print Setup...
B8 Print Preview...
H‘?ﬁ Print...

File | Edit View Bookmarks Insert Se
[ Mew.. Ctrl+N
B Open.. Ctrl+0
E save Ctrl+5
Save As..
Save A Copy...
Share As r
Add Data 4
Eﬁ Sign In...

I Export Map...

Analyze Map...

™ Map Document Properties...

2. You can then name the file, and select the map export format by using the Save
as type option.

Q Export Map

Savein: | E This PC

Yedeo b

* Folders (&)

Quick access

[h_ ) Music
ThisPC |

- Desktop
Desktop @ Documents

Downloads
Libraries

@ == Pictures
| =

[wiite World File

B videos N
File: name: |SpatiaI_NI_Map ~ I | Save |
Save as type: JPEG B Cancel
|- = Options Eglg
General | Fomat | oD
SVG
Resolution: 13 BMP
Width: [12¢ ] PG
He (1055 | —————
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Esri provides an extensive list of descriptions of map export formats.

You can specify the resolution at which the map is exported, a higher value will provide
a sharper image. However, this can also dramatically increase file size, and therefore
processing time.

Spatial NI cached services have been cached at 96dpi for optimised screen viewing.
However, these have also been configured for printing.

Saving

When you have finished working on a map you can save it and close ArcMap. Maps
are saved as documents on your hard drive using the name and folder location you
provide. All maps automatically have the .mxd file extension added to the map
document name.

1. To save a map select File, and then Save or Save As

Q Untitled - ArcMap
File | Edit View Bookmarks Insert 5e
[ Mew.. Ctrl+N
% Open. Ctrl+0
=l Save Ctrl+5
Save As...
Save A Copy...
Share As *
Add Data *
Eﬂ Sign In...
HH  ArcGIS Portal...
Page and Print Setup...
'm Print Preview...
LE*Q Print...
Printing

You use the Print tool to print a map in ArcMap, where you can print the data frame
view or the layout view of your map.

1. Select the view to print (data or layout)

File Edit | View | Bookmarks Insert Selecti
O g Data View .
&l. @l «Ef“1 Layout View

= Graphs »
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2. Click File = Print

Filel Edit View Bookmarks Insert  Seled

Ctrl+M
Ctrl+ 0

[ Mew..
Y% Open..
& Save Ctrl+5
Save As..

Save A Copy..

Share As

Add Data

Sign Out - dof_whetstonet@nigov.net
ArcGlS Portal...

Page and Print Setup...

Print Preview...

k(B B &6 &5

Print...

Export Map...
Analyze Map...

&

Map Document Properties...

Sharing Maps

3. The Print dialogue box will appear. Check the settings are correct and select

OK to print.
Print
Printer
Name: \\pr-alph-etptr01\Xerox7845
Status: Ready
Type: Xerox WorkCentre 7845 PS
Where: Xerox7845

Comments: Equitrac virtual queue

Printer Engine: |Windows Printer

Output Image Quality (Resample Ratio)

]
Fast Normal
Ratio:
Tiling

Tile Map to Printer Paper

All 1 Eileds)

4

Tiles from: 1 &= ko 1

Scale Map to fit Printer Paper

Number of Copies:

[JPrint to File

VI ' Properties... | D Printer Paper(s) that will be printed

l:l Map Page (Page Layout)
Sample Map Elements
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